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SimpTerm is a    Chinese communication program for MS - Windows 3.1.    It 
allows you to read Chinese text in BIG5, HZ or GB encoded format sending 
from a remote computer, even if you don't have a Chinese system installed 
on your PC computer.    It also provides VT- 100 terminal emulation and file 
transfer function.

To learn how to use Windows Help, press F1.
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Chinese Topics Index

Choose one of the following topics to get more information:

Display
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Input



SimpTerm Overview

SimpTerm is a shareware communication program for MS-Windows 3.1.
It is capable of displaying Chinese text without the need of underlying 
operational system support.

It can use commonly available BIG5 or GB encoded bitmap font displaying 
BIG5, HZ or GB Chinese text sending from a remote host computer.

In addition, SimpTerm provides following features:

Terminal Emulation:
VT-100/102, VT-52, and ANSI Color BBS.

File Transfer protocols:
Kermit

with 2048 byte long packet, file attribute extension, run length 
encoding and user configurable control character prefixing.

X/YMODEM
with CRC error checking, 1024 byte long packet and G option.

Screen Buffer:
800 line screen scroll back buffer (under 80 X 24 mode).
Configurable screen size of up to 132 columns, 92 rows.

Modem Dialer:
with 10 programmable speed dial buttons, and memory for 10 most 
frequently used numbers as well as modem initialization strings.

Miscellaneous:
48 programmable function keys
User configurable Microsoft 3D and Borland BWCC style dialog box.

See also 

System Requirement



System Requirement

SimpTerm requires an IBM PC compatible computer with a 286 or higher 
CPU, running Microsoft Windows 3.1 and a VGA or higher resolution graphics
card.    A mouse and a fast video card with SVGA capability are strongly 
recommended.

To display Chinese text by SimpTerm, you need one or more Chinese 
bitmap font files.

To use either the Microsoft 3D style dialog or Borland Custom Control style 
dialog, you need 

CTL3DV2.DLL or CTL3DV2.DLL and/or BWCC.DLL.

These files are available from many ftp sites on the Internet, and many dial 
up BBS systems.

SimpTerm will work without these files as a regular communication 
program.

See Also
Setup   SimpTerm  



Acknowledgments

Since the first beta release of SimpTerm on Jan. 20, 1994, many kind users 
around the world identified many missing features and bugs with various 
hardware/software.

I am indebted to all your suggestions and I would like to especially thank 
Yifeng Fu, my colleague in the Illinois Institute of Technology, for 
suggesting me to add Chinese text displaying capability to SimpTerm, and 
Jian Shi, Jun Aubrey Zhang, Norley Liu, Tianwei Xie, for their numerous
ideas, productive discussions and extensive testing.

Microsoft and MS-DOS are registered trademarks and Windows are trademarks of Microsoft 
corporation.    TrueType is a registered trademark of Apple Computer, Inc.    TwinBridge is a 
trademark of PC Express, Inc.    All other product names and services identified throughout this 
document are trademarks or registered trademarks of their respective companies.



Packing List

This version of SimpTerm comes with following files:

spterm.exe SimpTerm executable file
spterm.hlp Windows 3.1 help file for SimpTerm
spterm.ini Configuration file for SimpTerm
kfmgr.dll Chinese font management dynamic link

library
kfmgr.ini Configuration file for kfmgr.dll
vt100.scn VT-100 terminal emulation screen 

driver
vt100.kbd VT-100 terminal emulation keyboard 

driver
vt52.scn VT-52 terminal emulation screen driver
vt52.kbd VT-52 terminal emulation keyboard 

driver
ansi.scn ANSI terminal emulation screen driver
ansi.kbd ANSI terminal emulation keyboard 

driver
readme.txt ASCII format introduction file



Chinese Fonts

SimpTerm can use 16X16 GB encoded bitmap font to display HZ and GB 
encoded Chinese text, and 14X16 or 16X16 BIG5 encoded bitmap font to 
display BIG5 encoded Chinese text.

Font information is contained in kfmgr.ini in the form:
[Fonts]
gbfont=fontfile
big5font=fontfile

Where fontfile is font file name.    

For example:
[fonts] 
gbfont=myfont.fon
big5font=c:\font\cfont.fon

Font files can be stored in another drive/directory provided that the full path
name is given.    

You can change Chinese font at run time.    From File menu, choose Run 
Editor to start an editor.    Open KFMGR.INI and change the font name.    
After you save the change you made, from View menu, clear the Use 
Bitmap Font option, and then check this option again.    This will cause 
SimpTerm reload Chinese font using new information in the configuration 
file.



Using Different Dialog Styles

SimpTerm can display dialogs in 4 different styles.

Regular Normal Windows dialog style.
Microsoft 3D Microsoft 3D effect dialog style.
BWCC 3 Borland Custom Control dialog style 

with steel-gray background.
BWCC 4 Borland Custom Control dialog style 

with light gray background.

To choose different dialog styles, from Options menu, select Program 
Settings.    The Program Setup dialog will appear.    You can select a dialog
style from the Dialog Style group box.

If you can not select a particular style, the required file for that style is 
missing or is not installed properly.

For Microsoft 3D dialog style
Required File: 

Microsoft's CTL3DV2.DLL or CTL3D.DLL dynamic link library.
Location:

Windows system directory (default C:\WINDOWS\SYSTEM).

For BWCC 3 or BWCC 4 dialog style
Required File: 

Borland International's BWCC.DLL dynamic link library.
Location:

One of following directories
Windows directory (default C:\WINDOWS).
Windows system directory (default C:\WINDOWS\SYSTEM).
A directory listed in current PATH statement.

Note:
These two files are not distributed with SimpTerm.    They are freely 



available from many ftp sites and BBS systems.



Displaying Chinese Characters

Chinese characters can be displayed by either SimpTerm or a Chinese 
Windows System.

To display Chinese characters by SimpTerm, 
Install    Chinese bitmap font files if you haven't done so. 
Select the Use Bitmap Font option in SimpTerm's View menu.

To display Chinese characters by a Chinese Window System, 
Clear the Use Bitmap Font option in SimpTerm's View menu.

You should also choose an ASCII screen font with proper size to get best 
result.    Click here for a Demo.

Even if you are running a Chinese Window system, you can still use 
SimpTerm to display Chinese characters for faster display speed.

The advantages of using SimpTerm to display Chinese characters:
Fast speed, this is very important when using a fast modem.
You don't have to install a Chinese system on your computer.

The advantages of using a Chinese system:
You may have more choices of fancy Chinese font.
In some cases, you can use less memory for Chinese viewing.

More Information

SimpTerm stores Chinese font in memory at run time and doesn't do font 
scaling.    These will reduce the overhead of displaying Chinese character to 
the minimum.    The side effect of doing so is that it requires more memory. 
The memory requirement for Chinese font is around 400 KB for BIG5 mode, 
300 KB for HZ/GB mode and 700 KB if two instances of SimpTerm are 
running at the same time, one in BIG5 mode, the other in HZ/GB mode. But 
under Windows 3.1 386 Enhanced mode, one can use virtual memory to 
reduce this side effect.

If the Use Bitmap Option is cleared, memory used for Chinese font data as
well as the Chinese font engine will be released.    In this case, SimpTerm's 



memory requirement is just like that of a typical medium sized Windows 
application.

Some of the popular Chinese Window Systems are
Microsoft Windows 3.1 Chinese edition (BIG5 or GB version)
Chinese Star
TwinBridg

Note:
Depends on which version of these systems you are using, you may only use
them to display Chinese characters in one of the BIG5 mode or HZ/GB mode.
SimpTerm does not provide run time BIG5 <-> GB translation.



File Menu Commands

From this menu, you can choose different command to Open or Close a 
session log file, to Run an editor or to Exit the SimpTerm.

The default text editor is Windows NOTEPAD.    If you like to use another 
editor, you can change it by choosing Options menu, Program Settings.   
The Program Setup dialog will appear.    You can then enter the editor 
program's name in the Editor window in this dialog.

When you open a log file, anything sending from the remote host computer 
will be saved in a file on your PC.

When you open a log file, you can either create a new file name or choose 
an existing file.    In the later case, incoming information will append to the 
old file.

The incoming data is saved to log file as is.    You may have difficulty in 
viewing log files using a regular text editor, since the log file may contain VT
- 100 command strings.    You can however use an ANSI editor to read, edit 
log files.

In general, if you only log output from a UNIX cat or VAX/VMS type 
command, there will be not VT-100 command strings.    But still, you should 
use a editor that is capable of understanding UNIX style new line characters.

The log file feature is used mostly for debugging SimpTerm while testing 
this program.



Edit Menu Commands

In this menu, you can choose following commands

Copy Send text in the Windows clipboard to remote host 
computer.

Paste Copy selected text in the terminal window to Windows 
clipboard.

Send Send selected text in the terminal window to remote 
host computer. The text will not be copied to the 
Windows clipboard.

Refresh Screen Redraw the terminal window.

Under the Clear option, you can choose Clear Current Screen or 
Clear Screen Buffer to clear text in the current terminal window or 
in the entire screen scrollback buffer.

Toggle Selected and Toggle Screen will toggle on screen text between 
ASCII and GB encoded Chinese text.    They are useful if the incoming Chinese
HZ text is not properly formatted



Options Menu Commands

From this menu, you can choose different command to start following 
dialogs to change various SimpTerm settings:

Port Change communication port 
settings.

Terminal Set terminal window options, 
emulation mode, and screen colors.

Function Keys Program function keys.

Fonts Change screen font.

Program Settings Change dialog style or text editor.



View Menu Commands

From this menu, you can choose different command to set SimpTerm 
terminal window's working mode.

ASCII mode resets all Chinese displaying mode.

BIG5, GB and HZ mode can be selected to display Chinese text in different 
encoding format.

In HZ mode
Show HZ Escape Code toggles the HZ escape code display mode.

if checked, '~{', and '~}' escape code are shown as is.

HZ Magic Switch toggles the automatic insertion of HZ escape code.
if checked, '~{', and '~}' will be added as needed.

Use Bitmap Font option determines how to display Chinese character, 
by SimpTerm if checked AND Chinese bitmap fonts are installed.
by a Windows Chinese system otherwise.

Show Vertical Scroll Bar will turn on/off the terminal window's vertical 
scroll bar.    Under 640X480 mode, if vertical scroll bar is turned on, you may
have difficulty in displaying a full 80 character line.

Note:

SimpTerm's Chinese modes are almost compatible with a regular terminal.  
In general, there is no need to switch between a Chinese mode and the 
ASCII mode just to start or stop Chinese viewing.    Some of the differences 
are listed here

In Chinese modes, regular ASCII codes from 160 to 255 are treated as 
Chinese characters.
In HZ mode, a ~ will not be displayed until next character is coming.

When you switch between different terminal modes, the change will only 
take in effect when new text is coming from remote host computer.    Text in 
screen buffer won't be changed.

To use BIG5 and GB mode, you need an 8 bit connection, 8, n, 1 Port 
setting and set up SimpTerm to show 8 bit characters.    The later two 



options can be set from the Options Menu Port and Terminal dialog.

SimpTerm's Chinese font engine is very fast, and font placement is 
internally coded to match the ASCII font.    If you choose to use alternate 
Chinese program/system to view Chinese character, the display speed may 
be very slow.



Phone Menu Commands

From this menu, you can choose different command to Dial a number or 
hang up an established modem connection.    Currently, SimpTerm only 
supports modems using Hayes compatible modem control command.



Utilities Menu Commands

From this menu, you can choose different command to clear the 
communication port, send a break signal to remote computer or reset the 
SimpTerm terminal windows.

These commands are used to restore normal operation of the program.

Communication Port commands
Clear Comm. 
Port

Clear the communication port that is blocked by
phone line noise.

Send Break Send a break signal to remote host computer.

Send Long Break Send a longer break signal to remote host.

You can usually use this command to escape 
back to a terminal server to kill a bad telnet 
connection 

Terminal Reset commands

Soft Reset: Remove VT-100 terminal scroll region.

Hard Reset: Clear Screen, clear screen buffer, remove
VT-100 scroll region, set terminal to 80 
character per line Auto Line Wrap On, 
and position cursor to the upper left 
corner.

They are useful if the remote host computer send incorrect command to 
setup SimpTerm's terminal window, or a WWW, Gopher connection is 
suddenly broken, and SimpTerm's terminal window is in a strange state.



Transfer Menu Commands

From this menu, you can choose different command to start file transfer 
with different protocol, change file transfer directory, change file transfer 
settings and get information about the last file transfer statistics.

Send   or   Receive File  Start file transfer.

Finish Kermit Server Stop the remote Kermit server.

Change Dir. Change current working 
directory.

Transfer Setup Change file transfer settings.

Transfer Info. View statistics for the most 
recent file transfer operation.

Help Menu Commands

From this menu, you can choose different command to get help information 
on using SimpTerm.



Choose a Screen Font

The Screen Font dialog can be used to choose screen font for normal ASCII
text displaying.    A Sample text window will show you the selected font in 
current screen colors.    Actual font height and width values are given above 
the Sample text window.

Only fixed pitch fonts are supported.    In Windows 3.1, fixed pitched fonts 
are Fixed system, Courier, Courier New TrueType and Terminal.

Only regular and bold font styles are supported.    If you choose other font 
styles that SimpTerm is not able to display, a Not Supported message will
be shown in the Sample window.

If you have only one font, Courier New TrueType, in the selection box, 
chances are you select to use TrueType font only in your Windows.    This 
setting can be changed from the Windows Control Panel, Font dialog, 
TrueType Option.

In Chinese mode, the ASCII font selection will affect the Chinese character 
placement.    Click here for a Demo.    

As a guide line, the screen font chosen should have at least 8 pixel in width 
and 12 to 20 pixel in height.    

For example, under
640X480 VGA mode, use Courier New TrueType at 10 point font size and 
under 800X600 SVGA mode use 11 point font size.

More Information

In SimpTerm, each Chinese character is represented with two ASCII 
characters, and needs at least 16 pixel both in width and height.    If a 
regular ASCII character is 8 pixel in width, there will be no inter character 
space for Chinese character.    If a regular ASCII character is 9 pixel in width, 
a Chinese character will have 2 x 9 - 16 = 2 pixel of inter character space.    
In this case, Chinese text will look much better.    For inter line space, 
SimpTerm enforces a minimum of 18 pixel line height in Chinese mode.    If 
the ASCII font is too small, there will not be a balance between ASCII text 
and Chinese text.

You can download a 9X16 fixed pitch font for better displaying result from 
ftp site ftp.cica.indiana.edu under pub/pc/win3/fonts.    The file name is 
woafon14.zip.    A nice addition to the Terminal font family.





Input Chinese Character

This version of SimpTerm does not provide Chinese input function.    You 
need to use other programs to send Chinese character to SimpTerm.

Some of these programs include
MS-Windows Chinese edition
Chinese Star
TwinBridge
Way3100

While editing in HZ mode, you should remember to type escape sequence 
to begin a block of HZ text, if you don't use the automatic HZ escape 
insertion feature of SimpTerm.    You can store those escape code in 
function keys.    For example, store ~{ in F11 and ~} in F12.

When you turn on the HZ Magic Switch option from the View menu, 
SimpTerm will add HZ escape code automatically.    In this case there is NO 
need to type ~, { , and ~} to start or stop a block of HZ text.

When typing Chinese characters, you would better turn on the Show HZ 
Escape code option from the View menu.    SimpTerm and many editors 
running on the host computer need to know the actual cursor position to 
operate correctly.

On the remote host computer, use a Chinese compatible editor, such as 
CELVIS, CEMACS, etc.
Error correction during HZ mode editing is trouble some.    Currently, only 
backspace key works reasonably well.    Send a refresh screen command 
frequently to remote computer.    Usually, the command to do so is 

CTRL + L (in lower case).



Configure the Communication Port

The Port dialog can be used to setup communication port parameters.

Usually the setting will be 8, n, 1, that is 8 data bits, none parity, 1 stop
bit.

Parity Check can be left unchecked.

Flow Control's setting depends on many factors, your host computer, your 
modem, or even your modem's cable if it is an external one.    The default 
setting is none.

Note:
The Xon/Xoff flow control is not compatible with X/YMODEM file transfer 
protocols.
To display BIG5 or GB text, you need the 8, n, 1 port setting.



Set Terminal Options

The Terminal dialog set most of the options for the terminal display and 
keyboard.

In most cases, there is not need to change the default settings.

Options Short 
description

Default setting

Screen Size Characters per 
line
Lines per 
screen

80 columns
24 rows

Cursor Cursor shape. Underline

Backspace Key Backspace key 
mode
If you see a ^H
when you want 
to delete a 
character, 
toggle this 
setting

Destructive
Means pressing
backspace sends ASCII code 127
CTRL+backspace sends ASCII 
code 9 (Backspace)

Arrow Keys Extended 
keyboard arrow
key mode in 
terminal 
emulation

Numeric

May be changed by host 
computer

Keypad Keypad mode 
in terminal 
emulation

Numeric
May be changed by host 
computer

Misc. Set new line 
translations
Line wrap 
mode
Warning Beep 
Mode

Line Wrap checked
Warning Bell checked
These settings may be changed 
by host computer.

Emulation Terminal VT-100, 7 bit character (0 -- 



emulation 
mode and ASCII
character 
range
When 8 bit char
is checked, 
ASCII code 128 
to 256 will be 
displayed in 
the terminal 
window

127),
No auto answer
May be changed by host 
computer from 
VT -- 100 to VT -- 52

Screen Color When ANSI 
color is 
checked, 
screen color 
default to 
normal white 
text on black 
background 
and host 
computer will 
change 
terminal colors 
by sending 
special code

Otherwise, 
screen color is 
user defined.

User defined
May be changed by host 
computer
Under VT-100 mode, the host 
computer may
reverse the text and background
color.

To change line width, choose desired value from the Columns drop down 
list.
To change the terminal window line numbers, choose desired value from the
Rows drop down list.    Default setting is 80 columns, 24 rows.

SimpTerm supports 72 to 132 character per line and 20 to 96 lines per 
screen.

Note:
You may need to resize the terminal window so that all text could be 
displayed in the terminal window.



You also need to tell your host computer that you have a bigger screen.

On UNIX, the command to do so is usually

stty rows 32 cols 80

for a 80 character, 32 line screen.

Screen color of the terminal window can be set by click the Set Color 
button in the Terminal dialog.    The Screen Color dialog will appear.    From 
there, you choose Text Color and Screen Color from 16 color boxes and a 
small window will show you the effect.

If you check the Reverse button above the Set Color button, the actual 
color for text and background will be exchanged.

Screen color can also be controlled by the remote computer if the ANSI 
Color option is selected.    Many BBS systems can send control code to 
display fancy color text.

The 8 Bit Char. option determines whether SimpTerm will display ASCII 
characters in the range 128 to 256 decimal.    This option must be checked 
to view GB or BIG5 encoded Chinese characters as well as special IBM 
graphic characters used on many BBS systems.

In some cases, you need to left this setting unchecked.    For example, the 
remote host computer requires a 8, n, 1 port setting, but the computer's tty 
driver can't handle 8 bit character correctly, and there is a lot of garbage 
character on the terminal window.

In VT - 100 mode, a remote host computer may send a command to ask for 
an answer back string.    The Auto Answer option determines whether 
SimpTerm should honor this command.    This command is rarely used.    
You can edit this string in the Answer String edit window.    Even if the Auto
Answer is not turned on, you can still send this string to remote host by type
CTRL + PAUSE.



Function Keys

SimpTerm uses F1 to F12 as function keys. Along with Normal, Shift, 
Control and Control + Shift combination, there are total of 48 function keys 
available for programming.

Function keys can be programmed from View menu, choose Function 
Keys dialog.

In this dialog, there are 12 edit entries for F1 to F12.    By choosing one of 
the Normal, Shift, Control or Control Shift at the upper right corner of the 
dialog, the 48 function keys can be programmed individually.

After you edit any entry, you should click the Save button to save new 
changes.

For each entry, up to 80 characters can be stored.    For long strings, you can
use arrow keys to move back and forth so the edit point is coming into view 
in the edit window.

Control characters are prefixed with a ^ .    So carriage return CR is ^m, line 
feed is ^j, and CTRL-F is ^f.

On a real VT - 100 or VT - 52 terminal, there are four function keys - PF1 to 
PF4.    For most users, these keys are rarely used.    If you do need to use 
them, you have to clear F1 to F4 and left them empty.    SimpTerm will then
using F1 to F4 to send control code for VT - 100/52's PF1 to PF4 key codes.



File Transfer

To transfer files between your PC and remote host, you start the remote 
computer's file transfer program first.    Then from the SimpTerm's 
Transfer Menu, choose Send File or Receive File. 

If you choose Send File, the Send File dialog appears.    You choose files to
be sent and protocol to be used. For XMODEM protocol, only one file can be 
transferred each time. For others, you can select a group of files by holding 
down the Control key or Shift key while highlighting files.

If you choose Receive File, the Receive File dialog appears.    You select 
the protocol to be used and the directory you want the incoming files to be 
stored.    If you choose Kermit Get or XMODEM as transfer protocol, you 
also need to provide remote file name in the Remote File Name window.    
If you don't, another dialog will prompt you to enter remote file name.

In either case, you can click the Transfer Setup button to change File 
Transfer Settings.

Examples:
1 Receive files using Kermit.

kermit                            // Type this to start remote Kermit.
send *.txt                  // Ask Kermit send all files with .txt extension
Kermit ready to send file ... // remote Kermit is saying it's ready
At this point, you can do one of the followings

From Transfer menu, choose Receive File..., or type ALT+R.
The Receive File dialog will appear.    In the Receive File dialog, 
choose Kermit Receive from the Protocol list box, then choose 
OK. 

Type ALT+K

Kermit receive will start.

2 Send a file using Kermit.
kermit                            // Type this to start remote Kermit
receive                          // Tell Kermit enter receive mode



Kermit ready to receive ...    // remote Kermit is ready
From Transfer menu, choose Send File..., or type ALT+S.
The Send File dialog will appear.    In the Send File dialog, choose 
Kermit Send from the Protocol list box, then select a file from the file
list box at the left hand side.    When everything is ready, click OK.

Kermit send will start.



Cancel File Transfer

While a file transfer is undergoing, you can cancel the transaction from the 
File Transfer Dialog by clicking Abort.    A dialog will pop up so you can 
choose how to cancel the transfer.

For Kermit transfer, choose

Cancel File Cancel the file being transferred and skip to 
next file, if any.

Cancel Batch Cancel the entire file transfer session.

If the above two commands don't work, choose 

Cancel Nicely Send an error signal to the remote computer.

Cancel Abruptly. This will shut down local transfer function.

For X/YMODEM transfer, only Cancel Nicely and Cancel Abruptly two 
options are available.

Note:

When receive file using YMODEM-G protocol, it may be very difficult to 
cancel the transfer session.    Some programs on the remote host computer 
simply ignore a user's cancel request in YMODEM-G transfer mode.



Kermit Prefix Table

During a Kermit file transfer session, the Kermit protocol will add special 
characters to distinguish binary data and control characters.    This is known 
as control prefixing.    By default, binary data in the range 0 to 31, 127, 128 
to 159 and 255 decimal will be prefixed.    While this is needed for some 
network connection, it also adds significant overhead, resulting a slow 
transfer rate.

In SimpTerm, the control character prefixing can be controlled through a 
prefix table.    By prefixing only those control characters that must be 
prefixed, the through put of Kermit transfer can be increased ranging from 
10 % to 30 %.

The control prefixing table can be edited by click the Kermit Prefix Table 
button in the File Transfer Setup dialog.    This will bring up the Control 
Prefix Table dialog.    In this dialog, each control character is represented 
by a check box, in one of two groups - those in the range of 0 to 127 and 
those in the range of 128 to 255.    Clearing a check box will disable the 
control prefixing for the corresponding control character.    The Clear All and
Set All button will clear or check all check box respectively.    The Sync 
button will make the check boxes in two different groups have same state.

Note:
The remote Kermit program must be able to handle selective control 
prefixing.    
The control prefix table in SimpTerm only controls outgoing data.

SimpTerm can honor selective control prefixing in Kermit receive mode.    In
fact if the connection is 8 bit clean, there is no need to prefix any control 
character.    But for reliable transfer, prefixing for 0 and 1 is recommended.    
If you use Xon/Xoff flow control, prefixing of 17 and 19 is required.

For best result, you must try different combination depend on the remote 
host computer, the remote Kermit program, and the connection type (telnet,
rlogin, etc.)

In general, check these control characters to start your test:
0, 1, 3, 10, 13, 17, 19, 127 and their counterpart in the range 128 to 255 
decimal.





Copyright and Terms

SimpTerm - Version 0.8.0
A Chinese Communication Program for MS-Windows 3.1

Copyright (c) 1993, 1994 JIANQING HU
All rights reserved.

Author: JIANQING HU, 254 W. 31st ST. Chicago, IL 60616

Permission to use, copy, and distribute this software for non commercial 
purpose without fee is hereby granted, provided that the software is not 
altered, and that the above copyright notice and this permission statement 
appear in all such copies.

This software may not be used for commercial purpose without 
registration after a 10 day evaluation period.    Nor may it be, in whole or 
in part, licensed or sold for profit, included in or distributed with commercial
products or otherwise distributed by commercial concerns to their clients or 
customers without prior written permission of the copyright holder.

This software is provided "AS IS", WITHOUT WARRANTY OF ANY KIND.    THE 
AUTHOR AND COPYRIGHT HOLDER OF THIS SOFTWARE DISCLAIM ALL 
WARRANTIES OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, 
WITHOUT LIMITATION, IMPLIED WARRANTIES OF MERCHANTABILITY AND 
FITNESS FOR A PARTICULAR PURPOSE.    IN NO EVENT SHALL THE AUTHOR 
OR COPYRIGHT HOLDER OF THIS SOFTWARE BE LIABLE FOR ANY DAMAGES 
WHATSOEVER INCLUDING DIRECT, INDIRECT, INCIDENTAL, CONSEQUENTIAL,
LOSS OF BUSINESS PROFITS OR SPECIAL DAMAGES, EVEN IF THE AUTHOR 
OR COPYRIGHT HOLDER OF THIS SOFTWARE HAS BEEN ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGES.    SOME STATES DO NOT ALLOW THE 
EXCLUSION OR LIMITATION OF LIABILITY FOR CONSEQUENTIAL OR 
INCIDENTAL DAMAGES SO THE FOREGOING LIMITATION MAY NOT APPLY.



File Transfer Settings

File transfer parameters can be changed in the File Transfer Setup dialog.
Most of the parameters are for Kermit protocol.

You can choose different error checking method, packet size and 
compression option for a Kermit file transfer session.    You can also edit the 
Kermit Control Prefix table by clicking the Kermit Prefix Table button.

The Kermit protocol in SimpTerm is a partial implementation of the 
Columbia University's Kermit file transfer protocol.    The packet size is 
limited to 2048 byte maximum.    The transfer is done only in binary mode.    
Sliding window as well as locking shift is not implemented. 

The following two options are shared by all file transfer protocols.

Rename Duplicate File option will determine how to handle an incoming 
file with a name that is the same as a local file's name.    If checked, 
SimpTerm will give a new name to incoming file.

Discard Partial File option will determine how to handle an incomplete file
during file transfer.    If checked, SimpTerm will delete the incomplete file 
when a receiving transaction is failed.



Bugs and Limitations

This version of SimpTerm has following bugs and limitations:

VT-100 emulation
Double width and double height character not supported.
DEC graphics character not fully supported. If the screen font is OEM 
character set (for example Terminal), SimpTerm will do some translation.
Blink and Dim character attribute are not supported.
Bold character attribute is only supported when a TrueType regular style 
font is chosen as ASCII screen font.
Printer control command not supported.

ANSI emulation
Host controlled keyboard remapping not supported.

Copy and Paste
Only usable for current screen.    You must scroll desired text into view 
before choose copy, paste, or send.      Paste doesn't work in HZ mode as 
desired.

Terminal Window
Doesn't resize automatically when font, viewing mode is changed.

HZ Decoder/Encoder
Not as stringent as that specified in HZ 2.0 standard.    
The ~~ escape sequence is not honored, string will be displayed as is, so 
that the in HZ mode the terminal    is still compatible with a regular ASCII 
terminal.
The ~ character will not be added before a new line character.    A ~ 
character before a new line character will be displayed.    This is also for the 
compatibility with a regular terminal.    
As a result, you can use UNIX VI editor to view HZ file.
The decoder will tolerate many illegal HZ encoding formats so that it will 
display as much useful information as possible.    This does not mean to 
encourage these formats.

Chinese Font Engine



Only recognizes a limit number of bitmap fonts. Won't use fonts in more 
than one file.    The RAM requirement is relatively high.    SimpTerm 
currently stores all Chinese font in RAM.    The priority is given to fast display
speed.    For a computer with 4MB of RAM, this isn't a big trouble.    If you do 
have limit resource, say less than 2MB of RAM, try to use a Chinese system 
or program to display Chinese text.

Modem Dialer
Only Hayes compatible modems are supported. Hopefully they count for 
more than 90 % of modems.    If you have a modem that is not in this 
category, you must dial it manually or store some commands in function 
keys.

Internal Modem Handling
A small percentage of internal modems using VLSI chip to simulate a PC 
UART will hang the computer if not configured properly.    This is a 
compatibility problem between the modem and the Windows 
communication driver.
When a terminal program exits, or closes a communication port, the 
Windows communication driver checks the modem for certain response.    If 
in data connection mode, some modems will ignore this request, resulting 
the communication driver locks up the computer.    
If your modem has this behavior, remember to use SimpTerm's dialer to 
place a call and use the Hang--up command to disconnect before quit 
SimpTerm. 

Communication Port Handling
Still using pooling instead of Windows notification function.    This will avoid 
a bug in the Windows communication driver, but may consume more power 
on a notebook computer.



File Transfer Dialog

This dialog shows information during a file transfer session.    These include 
remote file name, local file name, local directory, current protocol, packet 
numbers transferred, bytes transferred for the current file, approximate 
throughput, retry and/or error number for the transfer session.    The total 
file size, and percentage transferred will also be shown if the information is 
available.

You can click the Hide button to hide this dialog and minimize the 
SimpTerm window. 
You can click the Abort button to Cancel File Transfer.

You can also move this dialog to other location and review the terminal 
window during a transfer session.



Trouble Shooting

This section lists some problems you may encounter while using 
SimpTerm.    Possible solutions are given.

Terminal

1 Terminal won't echo characters typed to the keyboard
Make sure SimpTerm is connected to a communication port (the window 
caption is SimpTerm on COMX, where X is 1 to 4).
Make sure you have a modem on that communication port.
Make sure the Scroll Lock on the keyboard is not pressed, toggle it if 
needed.
Check the communication settings for proper speed, parity, data bit size.

If all these are OK,
Send a long break signal by type Shift + Break, or choose Utilities menu, 
Send Long Break.
Change the port from the Port dialog to Comm. Port None, Speed 2400, 8 
Bit, Parity None, 1 Stop Bit, Flow Control None.    Select OK.    After 
SimpTerm changes its Title to SimpTerm - No Connection, change the Port 
setting to the port that your modem is connected.    This will reset the 
communication port.

2 Text can only be displayed in some portion of the terminal screen.
Make a Soft Reset from Utilities menu.

3 Some text lines always scroll out of terminal window.
The terminal window's size is not properly set.    Using the mouse to resize 
your terminal window until it can't go any larger.    If this doesn't work, 
change the screen font with a smaller one.

From the Terminal Setup dialog, choose 80 columns, 24 rows if you are using
a different setting.

Modem



1 Computer locks up when SimpTerm starts, or exits
Your internal modem is not fully compatible with Windows communication 
driver and the modem is connected to a remote host.
Turn of the computer's power, start everything again.    Use SimpTerm's 
dialer to place a call.    If you have to dial manually, send AT&D2 command 
to your modem before dial a number. See also Bugs and Limitations.

2 Modem Hang up problems
When using the Phone menu Hang Up command, the connection is closed,
but any further command sent to modem resulting an ERROR until the 
modem or computer is turned off and turned on again. 
Your modem has a slow response time, so the modem is not actually hang 
up.    Type an ATH command to the modem.    This will usually get the 
modem out of trouble.

After the modem is back to normal, type ATS7=20<return> to your modem.

3 When quitting SimpTerm or changing Communication Port to 
another one, the modem connection is lost.
This is the default behavior.    To overcome this, you must provide a 
command line switch -d to SimpTerm.    From Program Manager's window, 
high light the SimpTerm Icon (Click it ONCE).    Choose File menu, 
Properties.    In the Program Item Properties dialog, add -d to the end of
command line.    Be sure to leave a space between -d and spterm.exe.

File Transfer

1 Low throughput during file transfer
The host computer is very busy; The phone line is noisy while using an error
correction modem; You are using Kermit with short packet size, try to set the
packet size to 1000 or more.

2 Transfer always fails at certain point.
You are using X/YMODEM protocol, but you are using Xon/Xoff flow control 
for the communication port.    Disable the Xon/Xoff flow control.

3 Transfer never starts
X/YMODEM protocol needs an 8 bit connection. Make sure you set the 
communication port parameters to 8, n, 1.
The remote Kermit doesn't recognize selective control prefixing, or the 



network you connect to need certain control prefixing.    From the Transfer 
menu, choose Transfer Setup. In the up coming File Transfer Setup dialog, 
click Kermit Prefix Table button. The Control Prefix Table dialog will appear.    
Check all the check box by clicking the Set All button.    This will disable the 
selective control prefixing.
The remote Kermit is using another communication setting than yours. Make
sure the two computers have same communication settings - data bits, 
parity, stop bits.

4 Transfer fails frequently
The remote computer can't handle long packet size.    Using short packet 
size.    For Kermit, try to set packet size to a smaller value.    For 
XMODEM/YMODEM, using the short packet protocol for sending.
The remote Kermit program or the network you connect to can't handle 
selective control prefixing.    Disable the selective control prefixing. See last 
question.
You are using a high speed modem but your computer doesn't have a 16550
UART, or the 16550 UART is not used correctly by the Windows 
communication driver.
A 16550 UART can provide much better transfer performance under MS-
Windows than a regular 8250 or 16450 UART.    Use the program MSD.EXE 
comes with Windows to check if your computer has such a device.    Exit 
Windows and from the Windows directory type MSD.    Type C to see the 
COM Ports information and look for UART Chip Used.    You may want to read 
the sysini.wri file in the Windows directory for related settings for 
communication port under [386Enh] Section Settings(Using Windows Write, 
Page 7).



Program Speed Buttons

The dialer comes with SimpTerm has ten speed dial buttons, into which 
you can store frequently used phone numbers.

To program speed dial buttons, from Phone menu choose Dial to bring up 
the SimpDial dialog.

Click the Program button at the upper right corner of the SimpDial dialog.

The Program Speed Buttons dialog appears.    You can enter a phone number
and optionally a name for each of the ten speed button entries.    The first 9 
to 10 characters of a name will be displayed on the corresponding speed 
button's face in the SimpDial dialog.

After a speed button is programmed, you can click it in the SimpDial dialog
to dial the number it stores.

If you click a speed button that is empty, a small dialog will prompt you to 
enter a number and a name.



Dial to a Remote Computer

SimpTerm has a modem dialer - SimpDial.    From the Phone menu, 
choose Dial... to bring up this dialer, or simply type ALT + D (in lower case 
will do).

This dialer will remember 10 of your most frequently used phone numbers, 
10 of your most frequently used modem initialization strings and has 10 
Speed Buttons to store your favorite numbers.

The number you want to dial may be entered using keyboard, using mouse 
to click the numerical key pad in the SimpDial dialog, or choose a number 
from the pull down list of the phone number window if it is in the last 10 
mostly used number's list.

For frequently used numbers, you may store them into Speed Buttons, then 
click the speed button to dial the number.

If you want to dial some special code to disable features such as call 
waiting, enter those special codes to the Dialing Prefix window and check 
Use Prefix option.

The modem speed can be set from within the SimpDial dialog.    If you need
to set other communication port parameters, you should use the Options 
menu, Port dialog.

The dialer can also automatically adjust modem speed upon the connection,
if the AutoBaud option is checked.    This feature is only useful for modems 
with maximum speed of 2400 bps. or less.    With newer high speed 
modems, there are simply too many parameters need to be exchanged 
upon a connection, the use of AutoBaud is not recommended.

Before dialing a number, the modem can be initialized use the initialization 
string you entered in the Init. String edit window, or chosen from the last 
10 mostly used initialization string list.    The init. modem check box should
be checked to enable this feature.



Using the Mouse

SimpTerm has following special mouse operation features:

Double click Left Mouse Button
On a text string: Send that string to remote host 

computer.
On empty screen 
space:

Send a space character to remote 
host
computer.

Click Right Mouse Button
Send high lighted text to remote computer
OR
a Carriage Return if there is no high lighted text.



Keyboard Short Cut Keys

SimpTerm has following keyboard short cut keys:

ALT + S Brings up the Send File Dialog.
ALT + R Brings up the Receive File 

Dialog.
ALT + D Brings up the Dialer Dialog.
ALT + G Starts YMODEM-G Receive.
ALT + K Starts Kermit Receive.
ALT + X Starts XMODEM CRC Receive.
ALT + Y Starts YMODEM Receive.
ALT + / or . During file transfer, toggle 

focus between terminal 
window and the file transfer 
dialog window.



Contact the Author

For suggestions, bug report or for registration information to use SimpTerm
for commercial purpose, contact the author at

JIANQING HU
254 W. 31st ST. #3
CHICAGO, IL 60616
U.S.A.

Phone:
(01) 312 - 326 - 0200

Internet e-mail: (DO NOT use this for registration purpose)
thssjyh@iitmax.acc.iit.edu



Keyboard Index

See one of the following topics for more information.

Short Cut Keys
Special Keys
Screen Movement Keys
Using Function Keys



Screen Movement Keys
SimpTerm has a quite large screen buffer to hold text scroll out of screen.    
In addition to use the Windows vertical scroll bar, you can scroll back or 
forward the screen buffer with these keyboard short cut keys:

Page Up Scroll back one page
Page Down Scroll forward one page
CTRL + Home Scroll to the top of the buffer
CTRL + End Scroll to the bottom of the buffer
CTRL + Up Arrow Scroll up one line
CTRL + Down Arrow Scroll down one line

Note:
If the remote computer erases the current screen, those texts won't be 
stored in the screen buffer.

When you move around in the screen buffer, new text sending from the 
remote computer will be written to the portion of screen buffer that is in the 
terminal window instead of the bottom of the screen buffer



Special Keys

Scroll Lock Start or Stop receiving text from 
the remote computer.

Break Send a break to remote 
computer.

Shift + Break Send a long break signal to 
remote computer

CTRL + Break Send VT - 100 Answer Back 
string to remote computer

CTRL + Enter Send a Line Feed character to 
remote computer.



The SimpWatch Watch Dog

This dialog will keep the modem connection for you.
It sends a CR every 1 min.    So the remote host won't disconnect the line.

To start it, type ALT + W.



Setup SimpTerm

Put all files listed in the Packing List into one directory, say C:\SPTERM.

Add an icon for SimpTerm in your Windows Program Manager.    After that, 
you can double click the    icon to start SimpTerm.    It will run as a regular 
terminal program.    

In order to view Chinese text, you should install Chinese font files for 
SimpTerm or run a Chinese Windows system.

To use different dialog styles, you may need two files, CTL3D.DLL and 
BWCC.DLL.    

See the following topics for more information.

Installing Chinese font files for   SimpTerm  
Displaying Chinese characters
Using different dialog styles



Command Line Switches

SimpTerm has following command line switches:

-d Dialer won't enforce the &D2 command 
string.

-f Port can be closed faster.

-w The SimpWatch will work forever 
without the 4 min. limit.

See Program Manager's help for how to add command line switches.



Terminal Emulation

SimpTerm has 3 terminal emulation modes.

VT - 100 mode emulates a DEC VT - 100 terminal with some VT - 102's 
features, including inserting characters and deleting characters.    The PF1 to
PF4 keys are emulated with F1 to F4. But to use them, you should not 
program them as function keys.    See Program Function Keys section for 
more details. 

VT - 52 is provided mainly for the completeness of VT - 100 emulation, 
which requires the ability to enter VT - 52 mode.    

ANSI Color BBS emulation mode can be used to communicate with a BBS 
system capable of sending commands to change terminal screen color.    To 
enable ANSI color, from Options menu choose Terminal setup and in the 
Terminal Setup dialog, check ANSI color, 8 bit character and ANSI 
emulation.



Not a Topic

Watch Dog
Cool Switches



Choose and Run an Editor

From SimpTerm's File Menu, you can choose Run Editor to start an editor 
program.

The editor will be the Windows Notepad if you haven't selected another 
editor.

To select an editor other than Notepad, from the Options menu, choose 
Program Settings.    The Program Setup dialog will appear.

In the Program Setup dialog, type in an editor program's name in the 
Editor window.

If the program is not in a directory that is listed in the DOS' PATH, you must 
provide full path name.

For example, you have an editor named myedit.exe in C:\MYTOOLS, then 
you will type

c:\mytools\myedit.exe 
to the Program Setup dialog's Editor window.

You can choose whatever program you like, even if that is not an editor.
SimpTerm will simply run that program if possible.



SimpTerm Menu Index

Choose one of topics list below for detailed information:
File Menu Commands
Edit Menu Commands
Options Menu Commands
View Menu Commands
Phone Menu Commands
Utilities Menu Commands
Transfer Menu Commands
Help Menu Commands



Program Setup Dialog

You can use this dialog to 

Change Dialog Styles used by SimpTerm
or
Select an Editor for the File menu Run Editor command.



SimpTerm Author
Jianqing Hu
254 W. 31st STREET #3
Chicago, IL 60616



CTL3D Dialog Style



BWCC 3 Dialog Style



BWCC 4 Dialog Style



Screen Font Demo
The image only represents spacing for different font size.
640 X 480 / 800 X 600 mode 1024 X 768 mode



SimpTerm Quick Reference Copyright (c) 1993, 1994 Jianqing Hu

Keyboard Shortcuts:
Alt + D Dial a number.
Alt + G YMODEM-G receive.
Alt + K Kermit receive.
Alt + R Receive file.
Alt + S Send file.

Alt + X XMODEM CRC receive.
Alt + Y YMODEM receive.
Alt + / or . Toggle input focus between

terminal window and transfer 
window during file transfer.

Screen Buffer Movement:
Page Up/Down Scroll back/forward one screen.
Ctrl + Up/Down Scroll up/down one line.
Ctrl + Home/End Scroll to the top/bottom of    screen buffer.

Special Keys:
Break Send a break signal.
Shift + Break Send a long break signal.
Ctrl + Break VT - 100 Answer Back.

Scroll Lock Start or Stop receiving text.
Ctrl + Enter Send a Line Feed.

Special Mouse features:
Double click left Send the string under the cursor or a space if there is nothing under the cursor.
Click right button Send high lighted text or a carriage return if nothing is high lighted

Sample Chinese Font Configuration file - kfmgr.ini
[fonts]
gbfont=c:\fonts\kanji\gbfont.fon
big5font=c:\fonts\kanji\big5font.fon



Copyright and Terms
SimpTerm - Version 0.8.0

A Chinese Communication Program for MS-Windows 3.1
Copyright (c) 1993, 1994 JIANQING HU

All rights reserved.
Author: JIANQING HU, 254 W. 31st ST. Chicago, IL 60616

Permission to use, copy, and distribute this software for non commercial purpose without fee is hereby granted, 
provided that the software is not altered, and that the above copyright notice and this permission statement appear 
in all such copies.
This software may not be used for commercial purpose without registration after a 10 day evaluation period.    
Nor may it be, in whole or in part, licensed or sold for profit, included in or distributed with commercial products 
or otherwise distributed by commercial concerns to their clients or customers without prior written permission of 
the copyright holder.
This software is provided "AS IS", WITHOUT WARRANTY OF ANY KIND.    THE AUTHOR AND 
COPYRIGHT HOLDER OF THIS SOFTWARE DISCLAIM ALL WARRANTIES OF ANY KIND, EITHER 
EXPRESS OR IMPLIED, INCLUDING, WITHOUT LIMITATION, IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE.    IN NO EVENT SHALL THE 
AUTHOR OR COPYRIGHT HOLDER OF THIS SOFTWARE BE LIABLE FOR ANY DAMAGES 
WHATSOEVER INCLUDING DIRECT, INDIRECT, INCIDENTAL, CONSEQUENTIAL, LOSS OF BUSINESS
PROFITS OR SPECIAL DAMAGES, EVEN IF THE AUTHOR OR COPYRIGHT HOLDER OF THIS 
SOFTWARE HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.    SOME STATES DO NOT
ALLOW THE EXCLUSION OR LIMITATION OF LIABILITY FOR CONSEQUENTIAL OR INCIDENTAL 
DAMAGES SO THE FOREGOING LIMITATION MAY NOT APPLY.




